This page was intentionally left blank
# Authors

<table>
<thead>
<tr>
<th>Name</th>
<th>Affiliation</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. Modigliani</td>
<td></td>
</tr>
</tbody>
</table>
This page was intentionally left blank
## Change Record from previous Version

<table>
<thead>
<tr>
<th>Release</th>
<th>Affected Section(s)</th>
<th>Changes/Reason/Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1.0</td>
<td>All</td>
<td>First public release</td>
</tr>
<tr>
<td>1.1.3</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>1.2.0</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>1.4.1</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>1.4.4</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>1.5.0</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>1.6.0</td>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>
Contents

1 Introduction to Esoreflex ........................................ 9

2 Workflow Status .................................................. 10

3 Software Installation ............................................ 11
   3.1 Installing Esoreflex workflows via macports .............. 11
   3.2 Installing Esoreflex workflows via rpm/yum/dnf ........... 11
   3.3 Installing Esoreflex workflows via install_esoreflex .......... 11

4 Demo Data .................................................................. 13

5 Quick Start: Reducing The Demo Data .......................... 14

6 About the main esoreflex canvas ............................... 17
   6.1 Saving And Loading Workflows .............................. 17
   6.2 Buttons .......................................................... 17
   6.3 Workflow States ................................................ 17

7 The ERIS Workflow .................................................. 18
   7.1 Workflow Canvas Parameters ............................... 18
   7.2 Workflow Actors ............................................... 19
      7.2.1 Simple Actors ........................................... 19
      7.2.2 DataSetChooser ......................................... 19
      7.2.3 The ProductExplorer ................................. 20
      7.2.4 Lazy Mode ............................................... 22

8 Reducing your own data ............................................ 23
   8.1 The esoreflex command ..................................... 23
   8.2 Launching the workflow .................................... 23

9 Reducing and Calibrating Your Own Science Data with Reflex 26
   9.1 Available Reflex workflows ................................. 26
   9.2 Specifying data directories and selecting files ............. 26
9.3 Master Dark Creation .................................................. 28
9.4 Distortion ................................................................. 31
9.5 Detector Linearity ....................................................... 31
9.6 Master Flat ............................................................... 32
9.7 Wavelength Calibration ............................................... 33
9.8 Flux Standard Star Reduction ...................................... 34
9.9 Science Reduction ..................................................... 35
9.10 Examining the workflow results ................................... 37

10 Optimising Your Results Through Workflow Interaction 38
10.1 Interactive Windows .................................................. 38
   10.1.1 Buttons ............................................................ 38
   10.1.2 Recipe Parameters .............................................. 39
10.2 Improving quality of sky subtraction .......................... 39
   10.2.1 Case of compact sources and no dedicated sky frame .. 39
   10.2.2 Case of extended (and bright) sources and no dedicated sky frame . . . 40
   10.2.3 Case of long observations, with sky residuals .......... 40
10.3 Extraction problems .................................................. 41
   10.3.1 Case of extended objects .................................... 41
10.4 Known Problems ..................................................... 41
   10.4.1 Workflow Problems ........................................... 41

11 Frequently Asked Questions 44
1 Introduction to Esoreflex

This document is a tutorial designed to enable the user to reduce his/her data with the ESO pipeline run under an user-friendly environment, called EsoReflex, concentrating on high-level issues such as data reduction quality and signal-to-noise (S/N) optimisation.

EsoReflex is the ESO Recipe Flexible Execution Workbench, an environment to run ESO VLT pipelines which employs a workflow engine to provide a real-time visual representation of a data reduction cascade, called a workflow, which can be easily understood by most astronomers. The basic philosophy and concepts of Reflex have been discussed by Freudling et al. (2013A&A...559A..96F). Please reference this article if you use Reflex in a scientific publication.

Reflex and the data reduction workflows have been developed by ESO and instrument consortia and they are fully supported. If you have any issue, please have a look to https://support.eso.org to see if this has been reported before or open a ticket for further support.

A workflow accepts science and calibration data, as downloaded from the archive using the CalSelector tool\(^1\) (with associated raw calibrations) and organises them into DataSets, where each DataSet contains one science object observation (possibly consisting of several science files) and all associated raw and static calibrations required for a successful data reduction. The data organisation process is fully automatic, which is a major time-saving feature provided by the software. The DataSets selected by the user for reduction are fed to the workflow which executes the relevant pipeline recipes (or stages) in the correct order. Full control of the various recipe parameters is available within the workflow, and the workflow deals automatically with optional recipe inputs via built-in conditional branches. Additionally, the workflow stores the reduced final data products in a logically organised directory structure employing user-configurable file names.

This is the ESO-Reflex tutorial describing ESO-Rreflex reduction of ERIS-SPIFFIER data using the eris_spiffier workflow. The user is referred to the ERIS web page (https://www.eso.org/sci/facilities/paranal/instruments/eris/) for more information on the instrument itself, and the ERIS-SPIFFIER pipeline user manual for the details of the pipeline recipes (http://www.eso.org/sci/software/pipelines/). The workflow uses association rules known to work with files downloaded from the ESO archive with the CalSelector tool.

\(^1\) http://www.eso.org/sci/archive/calselectorInfo.html
2 Workflow Status

The ERIS-SPIFFIER Reflex workflow, in its current version, is capable, together with its underlying ERIS pipeline, of reducing ERIS-SPIFFIER data. The Reflex workflow was build by the ESO SCPPS ERIS Team.

The first step of the ERIS-SPIFFIER Reflex workflow is to organise the data of this instrument into an associated, organised, and classified structure including for each science, PSF-STD or normal STD observations files, the required instrument calibration files with matching high or low resolution spectral-band and preoptic settings. The user will be warned if any required calibration frames are missing.

The ERIS-SPIFFIER Reflex workflow, eris_spiffier, will correct the observed frames for their dark ans sky background level, flat-field the data, and generate a wavelength calibrated data cube with the spatial information along each X-Y plane and the wavelength information along the Z axis. A large number of data products are created and retained for the user to assess the quality of the pipeline processing.

During the processing within the Reflex workflow, the user has the ability to modify a number of pipeline parameters in order to optimise the data processing. This is done via interactive workflows that display the most important products and reduction parameters.

During the pipeline development, instrument commissioning, and the following experience of ERIS-SPIFFIER operations, the pipeline parameters have been set to default values that deliver the best results for the most cases. However, the user should make an effort to adjust and experiment with the parameters to optimize the results.
3 Software Installation

Esoreflex and the workflows can be installed in different ways: via package repositories, via the `install_esoreflex` script or manually installing the software tar files.

The recommended way is to use the package repositories if your operating system is supported. The pipelines and Reflex can be installed from the ESO `macports` repositories that support macOS platforms, and the `rpm/yum` repositories that support Fedora and CentOS platforms. For any other operating system it is recommended to use the `install_esoreflex` script.

The installation from package repository requires administrative privileges (typically granted via sudo), as it installs files in system-wide directories under the control of the package manager. If you want a local installation, or you do not have sudo privileges, or if you want to manage different installations on different directories, then use the `install_esoreflex` script. Note that the script installation requires that your system fulfill several software prerequisites, which might also need sudo privileges.

Reflex 2.11.x needs java JDK 11 to be installed.

Please note that in case of major or minor (affecting the first two digit numbers) Reflex upgrades, the user should erase the `${HOME}/KeplerData`, `${HOME}/.kepler` directories if present, to prevent possible aborts (i.e. a hard crash) of the esoreflex process.

3.1 Installing Esoreflex workflows via macports

This method is supported for the macOS operating system. It is assumed that macports ([http://www.macports.org](http://www.macports.org)) is installed. Please read the full documentation at [http://www.eso.org/sci/software/pipelines/installation/macports.html](http://www.eso.org/sci/software/pipelines/installation/macports.html), which also describes the versions of macOS that are currently supported.

3.2 Installing Esoreflex workflows via rpm/yum/dnf

This method is supported for Fedora and CentOS platforms and requires sudo rights. Please read the full documentation at [http://www.eso.org/sci/software/pipelines/installation/rpm.html](http://www.eso.org/sci/software/pipelines/installation/rpm.html), which also describes the versions of Fedora and CentOS that are currently supported.

3.3 Installing Esoreflex workflows via install_esoreflex

This method is recommended for operating systems other than what indicated above, or if the user has no sudo rights. Software dependencies are not fulfilled by the installation script, therefore the user has to install all the prerequisites before running the installation script.

The software pre-requisites for Reflex 2.11.5 may be found at: [http://www.eso.org/sci/software/pipelines/reflex_workflows](http://www.eso.org/sci/software/pipelines/reflex_workflows)

To install the Reflex 2.11.5 software and demo data, please follow these instructions:
1. From any directory, download the installation script:

   wget https://ftp.eso.org/pub/dfs/reflex/install_esoreflex

2. Make the installation script executable:

   chmod u+x install_esoreflex

3. Execute the installation script:

   ./install_esoreflex

   and the script will ask you to specify three directories: the download directory `<download_dir>`, the software installation directory `<install_dir>`, and the directory to be used to store the demo data `<data_dir>`. If you do not specify these directories, then the installation script will create them in the current directory with default names.

4. Follow all the script instructions; you will be asked whether to use your Internet connection (recommended: yes), the pipelines and demo-datasets to install (note that the installation will remove all previously installed pipelines that are found in the same installation directory).

5. To start Reflex, issue the command:

   `<install_dir>/bin/esoreflex`

   It may also be desirable to set up an alias command for starting the Reflex software, using the shell command alias. Alternatively, the PATH variable can be updated to contain the `<install_dir>/bin` directory.
4 Demo Data

Together with the pipeline you will also receive a demo data set, that allows you to run the Reflex eris_spiffierworkflow without any changes in parameters. This way you have a data set to verify the installation and to experiment with before you start to work on your own data. The demo data for ERIS-SPIFFIER includes example data for the workflow. Note that you will need a minimum of 3.5 GB, 1.5 GB and 4.4 GB of free disk space for the directories `<download_dir>`, `<install_dir>` and `<data_dir>`, respectively. The ERIS-SPIFFIER demo data have been retrieved with the CalSelector tool 2.
5 Quick Start: Reducing The Demo Data

For the user who is keen on starting reductions without being distracted by detailed documentation, we describe the steps to be performed to reduce the science data provided in the ERIS demo data set supplied with the esoreflex 2.11.5 release. By following these steps, the user should have enough information to perform a reduction of his/her own data without any further reading:

1. First, type:

   esoreflex -l

   If the esoreflex executable is not in your path, then you have to provide the command with the executable full path <install_dir>/bin/esoreflex -l. For convenience, we will drop the reference to <install_dir>. A list with the available esoreflex workflows will appear, showing the workflow names and their full path.

2. Open the ERIS SPIFFIER by typing:

   esoreflex eris_spiffier

   Alternatively, you can type only the command esoreflex the empty canvas will appear (Figure 5.1) and you can select the workflow to open by clicking on File -> Open File. Note that the loaded workflow will appear in a new window. The ERIS SPIFFIER workflow is shown in Figure 5.2.

3. To aid in the visual tracking of the reduction cascade, it is advisable to use component (or actor) highlighting. Click on Tools -> Animate at Runtime, enter the number of milliseconds representing the animation interval (100 ms is recommended), and click OK.

4. Change directories set-up. Under “Setup Directories” in the workflow canvas there are seven parameters that specify important directories (green dots).

   By default, the ROOT_DATA_DIR, which specifies the working directory within which the other directories are organised, is set to your $HOME/reflex_data directory. All the temporary and final products of the reduction will be organized under sub-directories of ROOT_DATA_DIR, therefore make sure this parameter points to a location where there is enough disk space. To change ROOT_DATA_DIR, double click on it and a pop-up window will appear allowing you to modify the directory string, which you may either edit directly, or use the Browse button to select the directory from a file browser. When you have finished, click OK to save your changes.

   Changing the value of RAW_DATA_DIR is the only necessary modification if you want to process data other than the demo data.

5. Click the button to start the workflow

6. The workflow will highlight the Data Organiser actor which recursively scans the raw data directory (specified by the parameter RAW_DATA_DIR under “Setup Directories” in the workflow canvas) and constructs the datasets. Note that the raw and static calibration data must be present either in
Reflex ERIS-SPIFFIER Tutorial

RAW_DATA_DIR or in CALIB_DATA_DIR, otherwise datasets may be incomplete and cannot be pro-
cessed. However, if the same reference file was downloaded twice to different places this creates a
problem as esoreflex cannot decide which one to use.

7. The Data Set Chooser actor will be highlighted next and will display a “Select Datasets” window
(see Figure 9.1) that lists the datasets along with the values of a selection of useful header keywords
\(^2\). The first column consists of a set of tick boxes which allow the user to select the datasets to be processed.
By default all complete datasets which have not yet been reduced will be selected. A full description of
the options offered by the Data Set Chooser will be presented in Section 7.2.2.

8. Click the Continue button and watch the progress of the workflow by following the red highlighting of
the actors. A window will show which dataset is currently being processed.

9. Once the reduction of all datasets has finished, a pop-up window called Product Explorer will appear,
showing the datasets which have been reduced together with the list of final products. This actor allows
the user to inspect the final data products, as well as to search and inspect the input data used to create
any of the products of the workflow. Figure 9.10 shows the Product Explorer window. A full description of
the Product Explorer will be presented in Section 7.2.3.

10. After the workflow has finished, all the products from all the datasets can be found in a directory under
END_PRODUCTS_DIR named after the workflow start timestamp. Further subdirectories will be found
with the name of each dataset.

Well done! You have successfully completed the quick start section and you should be able to use this knowl-
edge to reduce your own data. However, there are many interesting features of Reflex and the ERIS workflow
that merit a look at the rest of this tutorial.

---

\(^2\) The keywords listed can be changed by double clicking on the DataOrganiser Actor and editing the list of keywords in the second
line of the pop-up window. Alternatively, instead of double-clicking, you can press the right mouse button on the DataOrganiser
Actor and select Configure Actor to visualize the pop-up window.

Figure 5.1: The empty Reflex canvas.
Figure 5.2: ERIS SPIFFIER workflow general layout.
6 About the main esoreflex canvas

6.1 Saving And Loading Workflows

In the course of your data reductions, it is likely that you will customise the workflow for various data sets, even if this simply consists of editing the ROOT_DATA_DIR to a different value for each data set. Whenever you modify a workflow in any way, you have the option of saving the modified version to an XML file using File -> Export As (which will also open a new workflow canvas corresponding to the saved file). The saved workflow may be opened in subsequent esoreflex sessions using File -> Open. Saving the workflow in the default Kepler format (.kar) is only advised if you do not plan to use the workflow with another computer.

6.2 Buttons

At the top of the esoreflex canvas are a set of buttons which have the following functions:

- ![Zoom In](image) - Zoom in.
- ![Reset Zoom](image) - Reset the zoom to 100%.
- ![Zoom Fit](image) - Zoom the workflow to fit the current window size (Recommended).
- ![Zoom Out](image) - Zoom out.
- ![Run](image) - Run (or resume) the workflow.
- ![Pause](image) - Pause the workflow execution.
- ![Stop](image) - Stop the workflow execution.

The remainder of the buttons (not shown here) are not relevant to the workflow execution.

6.3 Workflow States

A workflow may only be in one of three states: executing, paused, or stopped. These states are indicated by the yellow highlighting of the ![Run](image), ![Pause](image), and ![Stop](image) buttons, respectively. A workflow is executed by clicking the ![Run](image) button. Subsequently the workflow and any running pipeline recipe may be stopped immediately by clicking the ![Stop](image) button, or the workflow may be paused by clicking the ![Pause](image) button which will allow the current actor/recipe to finish execution before the workflow is actually paused. After pausing, the workflow may be resumed by clicking the ![Run](image) button again.
7 The ERIS Workflow

The ERIS workflow canvas is organised into a number of areas. From top-left to top-right you will find general workflow instructions, directory parameters, and global parameters. In the middle row you will find five boxes describing the workflow general processing steps in order from left to right, and below this the workflow actors themselves are organised following the workflow general steps.

7.1 Workflow Canvas Parameters

The workflow canvas displays a number of parameters that may be set by the user. Under “Setup Directories” the user is only required to set the RAW_DATA_DIR to the working directory for the dataset(s) to be reduced, which, by default, is set to the directory containing the demo data. The RAW_DATA_DIR is recursively scanned by the Data Organiser actor for input raw data. The directory CALIB_DATA_DIR, which is by default within the pipeline installation directory, is also scanned by the Data Organiser actor to find any static calibrations that may be missing in your dataset(s). If required, the user may edit the directories BOOKKEEPING_DIR, LOGS_DIR, TMP_PRODUCTS_DIR, and END_PRODUCTS_DIR, which correspond to the directories where book-keeping files, logs, temporary products and end products are stored, respectively (see the Reflex User Manual for further details; [?]).

There is a mode of the Data Organiser that skips the built-in data organisation and uses instead the data organisation provided by the CalSelector tool. To use this mode, click on Use CalSelector associations in the Data Organiser properties and make sure that the input data directory contains the XML file downloaded with the CalSelector archive request (note that this does not work for all instrument workflows).

Under the “Global Parameters” area of the workflow canvas, the user may set the FITS_VIEWER parameter to the command used for running his/her favourite application for inspecting FITS files. Currently this is set by default to fv, but other applications, such as ds9, skycat and gaia for example, may be useful for inspecting image data. Note that it is recommended to specify the full path to the visualization application (an alias will not work).

By default the EraseDirs parameter is set to false, which means that no directories are cleaned before executing the workflow, and the recipe actors will work in Lazy Mode (see Section 7.2.4), reusing the previous pipeline recipe outputs if input files and parameters are the same as for the previous execution, which saves considerable processing time. Sometimes it is desirable to set the EraseDirs parameter to true, which forces the workflow to recursively delete the contents of the directories specified by BOOKKEEPING_DIR, LOGS_DIR, and TMP_PRODUCTS_DIR. This is useful for keeping disk space usage to a minimum and will force the workflow to fully re-reduce the data each time the workflow is run.

The parameter RecipeFailureMode controls the behaviour in case that a recipe fails. If set to Continue, the workflow will trigger the next recipes as usual, but without the output of the failing recipe, which in most of the cases will lead to further failures of other recipes without the user actually being aware of it. This mode might be useful for unattended processing of large number of datasets. If set to Ask, a pop-up window will ask whether the workflow should stop or continue. This is the default. Alternatively, the Stop mode will stop the workflow execution immediately.

The parameter ProductExplorerMode controls whether the ProductExplorer actor will show its window or not. The possible values are Enabled, Triggered, and Disabled. Enabled opens the Produc-
tExplorer GUI at the end of the reduction of each individual dataset. Triggered (default and recommended) opens the ProductExplorer GUI when all the selected datasets have been reduced. Disabled does not display the ProductExplorer GUI.

7.2 Workflow Actors

7.2.1 Simple Actors

Simple actors have workflow symbols that consist of a single (rather than multiple) green-blue rectangle. They may also have an icon within the rectangle to aid in their identification. The following actors are simple actors:

- The DataOrganiser actor.
- The DataSetChooser actor (inside a composite actor).
- The FitsRouter actor Redirects files according to their categories.
- The ProductRenamer actor.
- The ProductExplorer actor (inside a composite actor).

Access to the parameters for a simple actor is achieved by right-clicking on the actor and selecting Configure Actor. This will open an “Edit parameters” window. Note that the Product Renamer actor is a jython script (Java implementation of the Python interpreter) meant to be customised by the user (by double-clicking on it).

7.2.2 DataSetChooser

The DataSetChooser displays the DataSets available in the “Select Data Sets” window, activating vertical and horizontal scroll bars if necessary (Fig. 9.1).

Some properties of the DataSets are displayed: the name, the number of files, a flag indicating if it has been successfully reduced (a green OK), if the reduction attempts have failed or were aborted (a red FAILED), or if it is a new dataset (a black “-”). The column “Descriptions” lists user-provided descriptions (see below), other columns indicate the instrument set-up and a link to the night log.

Sometimes you will want to reduce a subset of these DataSets rather than all DataSets, and for this you may individually select (or de-select) DataSets for processing using the tick boxes in the first column, and the buttons Deselect All and Select Complete at the bottom, or configure the “Filter” field at the bottom
left. Available filter options are: "New" (datasets not previously reduced will be selected), "Reduced" (datasets previously reduced will be selected), "All" (all datasets will be selected), and "Failed" (dataset with a failed or aborted reduction will be selected).

You may also highlight a single DataSet in blue by clicking on the relevant line. If you subsequently click on Inspect Highlighted, then a “Select Frames” window will appear that lists the set of files that make up the highlighted DataSet including the full filename\(^3\), the file category (derived from the FITS header), and a selection tick box in the right column. The tick boxes allow you to edit the set of files in the DataSet which is useful if it is known that a certain calibration frame is of poor quality (e.g: a poor raw flat-field frame). The list of files in the DataSet may also be saved to disk as an ASCII file by clicking on Save As and using the file browser that appears.

By clicking on the line corresponding to a particular file in the “Select Frames” window, the file will be highlighted in blue, and the file FITS header will be displayed in the text box on the right, allowing a quick inspection of useful header keywords. If you then click on Inspect, the workflow will open the file in the selected FITS viewer application defined by the workflow parameter FITS_VIEWER.

To exit from the “Select Frames” window, click Continue.

To add a description of the reduction, press the button associated with the field “Add description to the current execution of the workflow” at the bottom right of the Select Dataset Window; a pop up window will appear. Enter the desired description (e.g. "My first reduction attempt") and then press OK. In this way, all the datasets reduced in this execution, will be flagged with the input description. Description flags can be visualized in the SelectFrames window and in the ProductExplorer, and they can be used to identify different reduction strategies.

To exit from the “Select DataSets” window, click either Continue in order to continue with the workflow reduction, or Stop in order to stop the workflow.

### 7.2.3 The ProductExplorer

The ProductExplorer is an interactive component in the esoreflex workflow whose main purpose is to list the final products with the associated reduction tree for each dataset and for each reduction attempt (see Fig. 9.10).

#### Configuring the ProductExplorer

You can configure the ProductExplorer GUI to appear after or before the data reduction. In the latter case you can inspect products as reduction goes on.

1. To display the ProductExplorer GUI at the end of the datareduction:

   - Click on the global parameter “ProductExplorerMode” before starting the data reduction. A configuration window will appear allowing you to set the execution mode of the Product Explorer. Valid options are:
     
     - "Triggered" (default). This option opens the ProductExplorer GUI when all the selected datasets have been reduced.

---

\(^3\)Keep the mouse pointer on the file name to visualize the full path name.
– “Enabled”. This option opens the ProductExplorer GUI at the end of the reduction of each individual dataset.
– “Disable”. This option does not display the ProductExplorer GUI.

• Press the button to start the workflow.

2. To display the ProductExplorer GUI “before” starting the data reduction:

• double click on the composite Actor "Inspect previously reduced data". A configuration window will appear.
  Set to "Yes" the field "Inspect previously reduced data (Yes/No)". Modify the field "Continue reduction after having inspected the previously reduced data? (Continue/Stop/Ask)". "Continue" will continue the workflow and trigger the DataOrganizer. "Stop" will stop the workflow; "Ask" will prompt another window deferring the decision whether continuing or not the reduction after having closed the Product Explorer.

• Press the button to start the workflow. Now the ProductExplorer GUI will appear before starting the data organization and reduction.

Exploring the data reduction products

The left window of the ProductExplorer GUI shows the executions for all the datasets (see Fig. 9.10). Once you click on a dataset, you get the list of reduction attempts. Green and red flags identify successful or unsuccessful reductions. Each reduction is linked to the “Description” tag assigned in the Select Dataset window.

1. To identify the desired reduction run via the “Description” tag, proceed as follows:

• Click on the symbol at the left of the dataset name. The full list of reduction attempts for that dataset will be listed. The column Exec indicates if the reduction was successful (green flag: "OK") or not (red flag: "Failed").

• Click on the entries in the field "Description" to visualize the description you have entered associated to that dataset on the Select Dataset window when reducing the data.

• Identify the desired reduction run. All the products are listed in the central window, and they are organized following the data reduction cascade.

You can narrow down the range of datasets to search by configuring the field "Show" at the top-left side of the ProductExplorer (options are: "All", "Successful", "Unsuccessful"), and specifying the time range (Last, all, From-to).

2. To inspect the desired file, proceed as follows:

• Navigate through the data reduction cascade in the ProductExplorer by clicking on the files.

• Select the file to be inspected and click with the mouse right-hand button. The available options are:
– Options available always:
  • Copy full path. It copies the full name of the file onto the clipboard. Shift+Ctrl+v to past it into a terminal.
  • Inspect Generic. It opens the file with the fits viewer selected in the main workflow canvas.
  • Inspect with. It opens the file with an executable that can be specified (you have to provide the full path to the executable).

– Options available for files in the TMP_PRODUCTS_DIR directory only:
  • command line. Copy of the environment configuration and recipe call used to generate that file.
  • Xterm. It opens an Xterm at the directory containing the file.

– Options available for products associated to interactive windows only:
  • Display pipeline results. It opens the interactive windows associated to the recipe call that generated the file. Note that this is for visualization purposes only; the recipe parameters cannot be changed and the recipe cannot be re-run from this window.

### 7.2.4 Lazy Mode

By default, all `RecipeExecuter` actors in a pipeline workflow are “Lazy Mode” enabled. This means that when the workflow attempts to execute such an actor, the actor will check whether the relevant pipeline recipe has already been executed with the same input files and with the same recipe parameters. If this is the case, then the actor will not execute the pipeline recipe, and instead it will simply broadcast the previously generated products to the output port. The purpose of the Lazy Mode is therefore to minimise any reprocessing of data by avoiding data re-reduction where it is not necessary.

One should note that the actor’s Lazy Mode depends on the contents of the directory specified by the parameter `BOOKKEEPING_DIR` and the relevant FITS file checksums. Any modification to the directory contents and/or the file checksums will cause the corresponding actor to run the pipeline recipe again when executed, thereby re-reducing the input data.

The re-reduction of data at each execution may sometimes be desirable. To force a re-reduction of data for any single `RecipeExecuter` actor in the workflow, right-click the actor, select Configure Actor, and uncheck the Lazy mode parameter tick-box in the “Edit parameters” window that is displayed. For many workflows the `RecipeExecuter` actors are actually found inside the composite actors in the top level workflow. To access such embedded `RecipeExecuter` actors you will first need to open the sub-workflow by right-clicking on the composite actor and then selecting Open Actor.

To force the re-reduction of all data in a workflow (i.e. to disable Lazy mode for the whole workflow), you must uncheck the Lazy mode for every single `RecipeExecuter` actor in the entire workflow. It is also possible to change the name of the bookkeeping directory, instead of modifying any of the Lazy mode parameters. This will also force a re-reduction of the given dataset(s). A new reduction will start (with the lazy mode still enabled), but the results of previous reduction will not be reused. Alternatively, if there is no need to keep any of the previously reduced data, one can simply set the `EraseDirs` parameter under the “Global Parameters” area of the workflow canvas to true. This will then remove all previous results that are stored in the bookkeeping, temporary, and log directories before processing the input data, in effect, starting a new clean data reduction and re-processing every input dataset. **Note:** `The option EraseDirs = true does not work in esoreflex version 2.9.x and makes the workflow to crash.`
8 Reducing your own data

In this section we describe how to reduce your own data set.

First, we suggest the reader to familiarize with the workflow by reducing the demo dataset first (Section 5), but it is not a requirement.

8.1 The esoreflex command

We list here some options associated to the esoreflex command. We recommend to try them to familiarize with the system. In the following, we assume the esoreflex executable is in your path; if not you have to provide the full path <install_dir>/bin/esoreflex

To see the available options of the esoreflex command type:

esoreflex -h

The output is the following.

-h | -help print this help message and exit.
-v | -version show installed Reflex version and pipelines and exit.
-l | -list-workflows list available installed workflows and from
~/KeplerData/workflows.
-n | -non-interactive enable non-interactive features.
-e | -explore run only the Product Explorer in this workflow
-p <workflow> | -list-parameters <workflow> lists the available parameters for the given workflow.
-config <file> allows to specify a custom esoreflex.rc configuration file.
-create-config <file> if <file> is TRUE then a new configuration file is created in ~/.esoreflex/esoreflex.rc. Alternatively a configuration file name can be given to write to. Any existing file is backed up to a file with a ‘.bak’ extension, or ‘.bakN’ where N is an integer.
-debug prints the environment and actual Reflex launch command used.

8.2 Launching the workflow

We list here the recommended way to reduce your own datasets. Steps 1 and 2 are optional and one can start from step 3.

1. Type: esoreflex -n <parameters> ERIS SPIFFIER to launch the workflow non interactively and reduce all the datasets with default parameters.
<parameters> allows you to specify the workflow parameters, such as the location of your raw data and the final destination of the products.

For example, type (in a single command line):

```
esoreflex -n
   -RAW_DATA_DIR /home/user/my_raw_data
   -ROOT_DATA_DIR /home/user/my_reduction
   -END_PRODUCTS_DIR $ROOT_DATA_DIR/reflex_end_products
eris_spiffier
```

to reduce the complete datasets that are present in the directory /home/user/my_raw_data and that were not reduced before. Final products will be saved in /home/user/my_reduction/reflex_end_products, while book keeping, temporary products, and logs will be saved in sub-directories of /home/user/my_reduction/. If the reduction of a dataset fails, the reduction continues to the next dataset. It can take some time, depending on the number of datasets present in the input directory. For a full list of workflow parameters type esoreflex -p ERIS SPIFFIER. Note that this command lists only the parameters, but does not launch the workflow.

Once the reduction is completed, one can proceed with optimizing the results with the next steps.

2. Type:

```
esoreflex -e eris_spiffier
```

to launch the Product Explorer. The Product Explorer allows you to inspect the data products already reduced by the ERIS SPIFFIER esoreflex workflow. Only products associated with the workflow default bookkeeping database are shown. To visualize products associated to given bookkeeping database, pass the full path via the BOOKKEEPING_DB parameter:

```
esoreflex -e BOOKKEEPING_DB <database_path> eris_spiffier
```

to point the product explorer to a given <database_path>, e.g., /home/username/reflex/reflex_bookkeeping/test.db

The Product Explorer allows you to inspect the products while the reduction is running. Press the button [Refresh] to update the content of the Product Explorer. This step can be launched in parallel to step 1.

A full description of the Product Explorer will be given in Section 7.2.3

3. Type:

```
esoreflex eris_spiffier &
```

to launch the ERIS SPIFFIER esoreflex workflow. The ERIS SPIFFIER workflow window will appear (Fig. 5.2). Please configure the set-up directories ROOT_DATA_DIR, RAW_DATA_DIR, and other workflow parameters as needed. Just double-click on them, edit the content, and press [OK]. Remember to specify the same <database_path> as for the Product Explorer, if it has been opened at step #2, to synchronize the two processes.

4. (Recommended, but not mandatory) On the main esoreflex menu set Tools—> Animate at Runtime to 1 in order to highlight in red active actors during execution.
5. Press the button 🎥 to start the workflow. First, the workflow will highlight and execute the `Initialise` actor, which among other things will clear any previous reductions if required by the user (see Section 7.1). Secondly, if set, the workflow will open the Product Explorer, allowing the user to inspect previously reduced datasets (see Section 7.2.3 for how to configure this option).
9 Reducing and Calibrating Your Own Science Data with Reflex

9.1 Available Reflex workflows

The workflow eris_spiffier (shown in Fig. 5.2) allows to reduce ERIS-SPIFFIER data.

9.2 Specifying data directories and selecting files

To reduce your own science data, simply change the paths to the root (optional) and data directories. Under the root directory, Reflex will create sub-directories which will contain temporary and end products, as well as book keeping and log files. The data directory, normally also under the root directory, contains directories with your raw files downloaded from the ESO archive. The paths are defined at the top of the workflow window in the area labeled Setup Directories. Simply double click on the RAW_DATA_DIR, enter the path to your raw science directory and then start the workflow in the same way as you did for the tutorial demo data. In case the data sets listed in the first window created by the workflow (Fig. 9.1) are greyed out, calibration files are missing (hovering with the mouse over the grey file entry will give more details). You can click the entry and a GUI opens up showing the dependency tree of the science (or calibrator) file on calibrations (Fig. 9.1).
Figure 9.1: The “Select Datasets” pop-up window.

Figure 9.2: The “Select Frame” pop-up window, obtained after pressing the “Inspect highlighted” button in the “Select Datasets” window.
Figure 9.3: The “Select Datasets” pop-up window. If required input data are missing, the corresponding dataset is grey out.

It may occur that the user misses some input data required to reduce a given dataset. In this case the affected dataset(s) are grey out. Moving the mouse over the grey datasets provides information about the missing data product to perform the chain (see Fig. 9.3). In such case the user should consult the pipeline user manual to identify which raw data allow to generate that data set and add to the input raw data set (of the appropriate instrument setting) to the missing data.

To better understand how to solve the grey out datasets and corresponding messages from ESOReflex pointer, we recommend the user to take advantage of the calSelector functionality selecting the option "Selected files + associated raw calibrations (if available)" and provide below the following table. On the left hand side column is reported the data set type indicated by the mouse pointer, and on the right we indicate what data are missing. Note also the OCA rules imply selections on a set of FITS keywords, thus the user may have some data of the type missing, but possibly not the ones that match the selection criteria. In this case the user would have to check the OCA rule implementation. The use of calSelector mentioned functionality usually overcome any of these possible residual problems.

9.3 Master Dark Creation

The signal on the detector when the shutter is closed is called dark (current) level. To measure the dark current a set of usually five dark frames is acquired and stacked into a master frame to reduce the noise present in each frame. The eris_spiffier workflow allows to inspect and eventually optimise the main results of the master dark recipe.

The interactive workflows allows by selecting the appropriate button to display the Master Dark, the Hot Pixel Mask, the average of the master dark along a column or along a row, and an Histogram of the master dark data points.
### Reflex message

<table>
<thead>
<tr>
<th>Reflex message</th>
<th>missing raw data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Missing MASTER_DARK_IFU_WKF</td>
<td>raw dark frames</td>
</tr>
<tr>
<td>Missing BPM_DARK_WKF</td>
<td>raw dark frames</td>
</tr>
<tr>
<td>Missing BPM_DETLLIN_WKF</td>
<td>raw linearity frames</td>
</tr>
<tr>
<td>Missing BPM_DIST_WKF</td>
<td>raw North South Test frames</td>
</tr>
<tr>
<td>Missing DISTANCES_WKF</td>
<td>raw North South Test frames</td>
</tr>
<tr>
<td>Missing DISTORTION_WKF</td>
<td>raw North South Test frames</td>
</tr>
<tr>
<td>Missing SLITLET_POS_WKF</td>
<td>raw North South Test frames</td>
</tr>
<tr>
<td>Missing MASTER_FLAT_WKF</td>
<td>raw flat frames</td>
</tr>
<tr>
<td>Missing BPM_FLAT_WKF</td>
<td>raw flat frames</td>
</tr>
<tr>
<td>Missing WAVE_MAP_WKF</td>
<td>raw arc lamp frames</td>
</tr>
<tr>
<td>Missing RESPONSE</td>
<td>raw flux std star frames</td>
</tr>
</tbody>
</table>

**Table 9.1**: This table reports the possible message indicated by the cursor when moved on a grey out dataset, and the corresponding missing raw data type, the user has to retrieve from the ESO archive to obtain a complete data set.

The user may modify a number of data reduction parameters, like the method used to determine the bad pixels, the method used to collapse dark frames in a master, and the low and high values used in the kappa sigma clipping iteration to flag outliers.
Figure 9.4: The interactive window to edit parameters of recipe eris_ifu_dark.
9.4 Distortion

Figure 9.5: The interactive window to edit parameters of recipe eris_ifu_distortion.

The interactive workflow allows to display the corresponding distortion recipe product bad pixel map, or the right-to-left slitlets traces’ edges distances.

The user may optimise results changing some common parameters, parameters that control the bad pixel detection, the flat creation or the distortion step.

9.5 Detector Linearity

The pixel to pixel detector sensitivity maybe not linear over the usual illumination range. For this reason the pipeline implements a recipe, eris_ifu_detlin, that analyses a set of flat frames acquired with different exposure times (and thus illumination levels), to measure the response of each pixels to different levels of input signal and fit a low order polynomial to identify in what intensity range the detector starts to have a not linear response. Current release does not support interactivity for this data reduction step.
9.6 Master Flat

![Interactive window to edit parameters of recipe eris_ifu_flat.](image)

Figure 9.6: The interactive window to edit parameters of recipe eris_ifu_flat.

The interactive workflow allows the user to display the master flat image, the spectrum of the column average over all raws versus the ones at three different reference column positions, or the spectrum of the raw average over all columns versus the ones at three different reference raws positions.

The user may optimise results changing some common parameters, parameters that control the badp pixel detection, or the flat creation step.
9.7 Wavelength Calibration

![Figure 9.7](image)

The interactive window to edit parameters of recipe eris_ifu_wavecal.

The interactive workflow allow the user to display the WAVE_LAMP.Stacked frame resulting by the stacking of all the frame difference obtained with the arc lamps switched on and off, the corresponding resampled frame to verify that the brick-wall pattern characteristic of the raw data has been removed, or the wavelength map, an image whose intensity at each pixel corresponds to the corresponding wavelength.

The user may optimise results by changing a few common parameters.
9.8 Flux Standard Star Reduction

The interactive workflow allows the user to display the image of a cube slice at a given plane id of the observed flux standard star (top left), and the image of the corresponding mean obtained collapsing the cube along the wavelength direction (top right), or the same information obtained for the mosaic-combined set of cubes, or (if available) the same information of the sky cube. On the bottom left hand side the user may display the image of the extracted spectrum, the one of the computed efficiency or the one of the computed instrument response.

The user may optimise results by selecting general parameters, parameters controlling the sky correction (for example with the Davies method, if a sky frame is available), the cube creation, the differential atmospheric refraction correction, or the cube resampling.

As ERIS is an instrument mounted at the Cassegrain focus of a VLT UT, and thus subject to flexures during night observations, the user must input the input static frame with PRO.CATG=OH_SPEC in order to obtain a wavelength calibration based on OH lines. This is the case reducing data with ESOReflex.

The Davies sky correction method can be used only if the data set contains an input sky frame.

In current release the cube resampling is a time consuming process. The user may slightly improve performance by reducing the loop-distance parameter from 3 to 1, however there are cases where such change may lead to bad resampling quality (chess-board pattern on the resampled planes).

Figure 9.8: The interactive window to edit parameters of recipe eris_ifu_stdstar on flux STD star data.
9.9 Science Reduction

![Interactive Window]

Figure 9.9: The interactive window to edit parameters of recipe eris_ifu_jitter.

The interactive workflow allows the user to display the image of a cube slice at a given plane id of the observed object (top left), and the image of the corresponding mean obtained collapsing the cube along the wavelength direction (top right), or the same information obtained for the mosaic-combined set of cubes, or (if available) the same information of the sky cube. On the bottom left hand side the user may display the image of the extracted spectrum.

The user may optimise results by selecting general parameters, parameters controlling the sky correction (for example with the Davies method, if a sky frame is available, or with other methods controlled by the parameter aj-method as described later), the cube creation, the differential atmospheric refraction correction, or the cube resampling.

As ERIS is an instrument mounted at the Cassegrain focus of a VLT UT, and thus subject to flexures during night observations, the user must input the input static frame with PRO.CATG=OH_SPEC in order to obtain a wavelength calibration based on OH lines. This is the case reducing data with ESOReflex.

The Davies sky correction method can be used only if the data set contains an input sky frame.

In case the user does not have dedicated sky frames the sky level can be obtained with several possible models. Each model is selected by the parameter aj-method. Possible values are 0: no sky subtraction. 1: sky is taken
from the next in MJD-OBS object frame. 2: sky is taken from the median of all input sky frames. 3: sky is taken from the mean of all input sky frames. 4: sky is taken from the median of user spec. rect. box; 5: sky is taken from the median of 4 regions at FOV edges; 6: sky is taken from the median of 8 regions at FOV edges; 7: sky is taken from each cube slice based on ks-clip based mask computed on collapsed cube.8: sky is taken from each cube slice based on 25% clip based mask computed on collapsed cube. The method 1, 2, 3 requires the user has planned the observation sequence properly, moving the object in the Field Of View enough that the position of the object in the next frame in the sequence does not overlap with the one of current frame. In such case method 1 is the most accurate. Otherwise we recommend option 8 (if there are at least 25% of pixels in each cube slice that can be attributed to the object and the median or the mean computed over the sky pixels is a good enough approximation). As alternative option 7 is recommended if the user has less than 25% pixels allocated to the sky or if the user has much more than 25% pixels allocated to the sky and would like to have an sky model based on a larger statistic. In the unfrequent case the user has a crowded field and no sky frame, the options to be used are 6, 5 or 4. Option 6 and 4 are recommended if there is only sky at the FOV edges. Option 4 has to be used if the user wants to specify the position where to evaluate the model. In such case the sky value will be based on a usually few pixels, the one included in the sky region. The user can fine tune the model by selecting the following parameter values:

- **sky-box-center**: The centre of the rectangular sky region (pixel). Two integers each in the range [1,64].
- **sky-box-width**: The rectangular (small) sky region x,y half widths [pixel]. Two integers each in the range [0,10].
- **sky-box-edges-margin**: The (small)number of x, y pixels taken as margining to the FOV edges so that sky regions (aj-method=5,6) do not include pixels at the edges of the re-sampled image [pixel]. Two integers each in the range [0,5].
- **sky-est-method**: On pixels set by aj-method this parameter allow to use the median (0) or the mean (1) [0]
- **sky-est-kappa**: On pixels set by aj-method this parameter allow to use the kappa of the kappa sigma clip iteration [3].
- **sky-est-niter**: On pixels set by aj-method this parameter allow to set the number of the kappa sigma clip iterations [5].

In current release the cube resampling is a time consuming process. The user may slightly improve performance by reducing the loop-distance parameter from 3 to 1, however there are cases where such change may lead to bad resampling quality (chess-board pattern on the resampled planes).
9.10 Examining the workflow results

When the workflow has finished, the Product Explorer window opens (Fig. 9.10). Select a data file and unfold the file tree in the “Provenance Tree” window. This provides information on the dependency of product files on the calibration files and other files from recipes executed before. You can inspect a data file by clicking the “Inspect with...” button, and entering the path to your favourite FITS file viewer (e.g., fv).

Figure 9.10: The ERIS-SPIFFIER product explorer for the eris_spiffier workflow.
10 Optimising Your Results Through Workflow Interaction

In this section, we use the information from previous sections along with the ERIS-SPIFFIER use cases selected with the purpose of describing how to optimise selected products data quality in the corresponding cases. This is achieved by interaction with the workflow actors via interactive windows displayed at key data reduction points in the data flow, which enable iteration of certain recipes in order to obtain better results.

We recommend that the user has already carried out the reductions for all the data sets as described in Section 5, although this is not a pre-requisite to following this section. By doing this, the user will be taking advantage of the workflow Lazy Mode, with minimal waiting time between various pipeline recipe executions.

Please follow the steps in the next subsections in order to optimise the reductions for the ERIS-SPIFFIER data.

The data reduction recipes of standard calibrations are generally very robust and need no optimization. Reduction of standard star data is usually simpler and less challenging than reduction of targeted object observation as the sources are point like and with high SNR ratio.

10.1 Interactive Windows

All interactive windows in the X-shooter workflow have the same basic structure. The left part is occupied by displays, while the right part provides access to selected pipeline recipe parameters and information about files used to create the currently displayed results.

Help for each of these features may be accessed by leaving the mouse pointer for about one second over the plot/parameter/button for which information is required. Note that the recipe parameters are grouped via labels at the top of the “Recipe Parameters” box that may be left-clicked to reveal the associated parameters.

10.1.1 Buttons

The panel of buttons at the top-left of the interactive window may be used to manipulate the displayed plots. The buttons have the following functions:

- ![Reset](image) - Reset all the plot ranges to their original values.
- ![Undo](image) - Undo the last modification of the plot ranges (if possible).
- ![Redo](image) - Redo the next modification of the plot ranges (if possible).
- ![Shift](image) - Selecting this button allows the user to use the mouse to shift the plot ranges by left-clicking on the target plot canvas and then dragging the mouse around while keeping the left mouse button held down, and releasing when ready.
- ![Zoom](image) - Selecting this button allows the user to zoom in on each plot by left-clicking on the target plot canvas to mark the top-left corner of a rectangle and then dragging the mouse to the bottom-right corner of the rectangle and releasing. The plot ranges will then be modified to match the rectangle that was defined.
The following constraints can be made by holding simultaneously a key while pressing the left mouse button:

- Constrain pan/zoom to x axis: hold X
- Constrain pan/zoom to y axis: hold Y
- Preserve aspect ratio: hold Ctrl

- Clicking this button opens a “Configure subplots” window that allows the user to adjust the spacing and positioning of the individual plots.

- Clicking this button opens a “Save to file” window which allows the user to save a screenshot of the current interactive window.

- Clicking this button allows the user to change the display levels of an image by clicking on pixels within the image (similar to ds9).

Use these buttons to inspect the plots in the interactive window in more detail.

### 10.1.2 Recipe Parameters

Left-clicking on the tabs on the right provides a list of configurable recipe parameters. To change a parameter left-click on the field with the value besides the parameters name. Then click the Re-run recipe button to re-run the recipe with the new parameter setting, which will close the interactive window and process the data again with the new parameter settings. The new results will appear in a new version of the interactive window.

We describe here only what we believe are the most frequent cases. Each user may have special observations with goals that may go beyond what described here that we cannot address.

### 10.2 Improving quality of sky subtraction

#### 10.2.1 Case of compact sources and no dedicated sky frame

Certain users may observe very dim and compact targets and decide not to use observing time for dedicated acquisition(s) of sky frames. Being the sky emission in NIR very strong it remains the problem of estimating and correcting the sky. In case of compact objects, if the observation sequence is properly planned, moving the instrument FOV so that the detected object images (without object PSF overlap) on different portions of the detector in the observation sequence, the user can combine the information from different frames to estimate and then subtract the sky. For example the user may subtract the next frame in MJD-OBS sequence to the current one to obtain a properly (near the object region) sky corrected frame (aj-method=1). Such frame will show negatives pattern of the object far from the object. Those can be used to increase the SNR of the user information with user-developed post-data reduction scripts.

An example of such observation, in a very peculiar case of a four time lensed quasar can be seen in Figure 10.1.
10.2.2 Case of extended (and bright) sources and no dedicated sky frame

Another very peculiar observation where the user can optimise results by changing parameters controlling the sky subtraction is shown in figure 10.2. In this case the user is observing an object, RMC-136 that has several components filling the entire SPIFFIER field of view. To optimise the observing time the user decided not to acquire a dedicated sky frame. Differently from the previous case, while the object is bright, the problem is that it fills the full field of view and thus to design a special observing sequence that enable to correct the sky with next frame in MJD-OBS sequence it’s not a valid option. Being the NIR sky very strong it remains the problem to estimate it from the data and correct it. In figure 10.2 we show results without sky subtraction (left) and with a sky modeled (aj-method=7) from the median of the pixels remaining after kappa-sigma clip of the detected sources, and later subtracted. Results are good. Even better results maybe obtained by the user by selecting the appropriate sky region (aj-method=4).

10.2.3 Case of long observations, with sky residuals

If the user has no dedicated sky frame and observations with long exposure time one may set aj-method to 4 and choose a proper sky window or set aj-method to 7. If the user has a dedicated sky frame to improve sky residuals the user may choose to activated the Davies sky model by setting sky_tweak to 1 and tbsub to true.
10.3 Extraction problems

10.3.1 Case of extended objects

The RMC-136 example is appropriate also to remind the user that the extraction algorithm usually perform the extraction of a region that is automatically determined by identifying where the source is. This works as far as the source is reasonably compact and possibly point-like. In case of extended or multiple sources we leave the user to select via the parameters center and radius the region where the object is extracted.

10.4 Known Problems

Below we provide a list of known problems for ERIS data, and solutions when possible.

10.4.1 Workflow Problems

1. Science interactivity report a problem possibly due to a recipe failure or choice of wrong input parameters

We are aware of a number of cases where the recipe maybe failing. We recommend the user to look at the recipe log.
Figure 10.3: This figure shows the message reported in case of failure in the ESOReflex interactivity. This can occur due to a recipe not generating the data products required by the GUI to display results. Sometimes this is due to the choice of parameters.

There is a case when the recipe does not fail but the Reflex interactive workflow does not display the usual products. This case occurs when the size of the combined wube is larger than a limit we have set to prevent the recipe spend too much time in generating a combined data cube. Current default for the parameter `max-cubes-centres-dist` is 240. If the size of the output cube is larger than this number the combined data cube is not created. As that data cube is the main data product that the science GUI displays, if that misses an error message is reported.

A simple solution for this problem is to increase the value of the `max-cubes-centres-dist` parameter.

We note that in any case the recipe makes sure the size of the combined cube (or better the length of the diagonal of each plane of the combined cube) is less than 1000.

One of those cases is when the user on purpose decide to observe within the same template portions of the Sky that are very distant one from the other.

2. Science recipe fails when `sky_tweak` is set to 1 (or to 2)
Figure 10.4: This figure shows at the left hand side (a) results in a normal case, after increasing the value of the parameter `max-cubes-centres-dist`, in this case to 640. The collapsed mean panel shows two sub-images interleaved by ‘white’ space. This reflects the fact the user desired to observe two portions of the sky disjoint one from the other, as evident on the finding chart displayed at the right hand side (b).

If the user chooses to model and correct the sky emission with the Davies (sky_tweak=1) or SkyCorr (sky_tweak=2) model, a dedicated sky frame is required in input as used by those methods. We remind users that, if a sky frame is not available, the pipeline allows sky correction only using the object frames (or better portion of them), and this is possible using the `aj-method` parameter.

3. Science recipe fails when aj-method is set to 8

As indicated by the `erif_ifu_jitter` recipe on-line help, in case aj-method is set to 8, the sky is modeled on each cube slice using a mask that clips all pixels but the 25% ones with lower intensity. This mask is determined on the (wavelength) collapsed cube (image). This method is computationally very efficient. However it requires to have at least 25% of the observed pixels that are clearly imaging portion of the Sky. There are cases where this is not true or most of them are flagged as bad. In this case such method may return an error. In those cases we recommend to set aj-method to 7.
11 Frequently Asked Questions

• The error window fills the whole screen - how can I get to the Continue/Stop buttons?
  Press the Alt key together with your left mouse button to move the window upwards and to the left. At
  the bottom the Continue/Stop buttons will be visible. This bug is known but could not yet be fixed.

• I tried to Open (or Configure) an Actor while the workflow is running and now it does not react
  any more. What should I do?
  This is a limitation of the underlying Kepler engine. The only way out is to kill the workflow externally. If
  you want to change anything while a workflow is running you first need to pause it.

• After a successful reduction of a data set, I changed this data set in some way (e.g. modified or
  removed some files, or changed the rules of the Data Organizer). When I restart Reflex, the Data
  Set Chooser correctly displays my new data set, but marks it as “reduced ok”, even though it was
  never reduced before. What does this mean?
  The labels in the column “Reduced” of the Data Set Chooser mark each dataset with “OK”, “Failed” or
  “-”. These labels indicate whether a data set has previously successfully been reduced at least once, all
  previous reductions failed, or a reduction has never been tried respectively. Data sets are identified by
  their name, which is derived from the first science file within the data set. As long as the data set name is
  preserved (i.e. the first science file in a data set has not changed), the Data Organizer will consider it to
  be the same data set. The Data Organizer recognizes any previous reductions of data sets it considers to
  be the same as the current one, and labels the current data set with “OK” if any of them was successful,
  even if the previously reduced data set differs from the current one.

  Note that the Product Explorer will list all the previous reductions of a particular data set only at the
  end of the reduction. This list might include successful and/or unsuccessful reduction runs with different
  parameters, or in your case with different input files. The important fact is that these are all reductions
  of data sets with the same first raw science file. By browsing through all reductions of a particular raw
  science file, the users can choose the one they want to use.

• Where are my intermediate pipeline products?
  Intermediate pipeline products are stored in the directory <TMP_PRODUCTS_DIR> (defined on the workflow canvas, under Setup Directories) and organised
  further in directories by pipeline recipe.

• Can I use different sets of bias frames to calibrate my flat frames and science data? Yes. In fact
  this is what is currently implemented in the workflow(s). Each file in a DataSet has a purpose attached to
  it ([?]). It is this purpose that is used by the workflow to send the correct set of bias frames to the recipes
  for flat frame combination and science frame reduction, which may or may not be the same set of bias
  frames in each case.

• Can I run Reflex from the command line? Yes, use the command:

  esoreflex -n <workflow_path>/<workflow>.xml

  The -n option will set all the different options for Kepler and the workflows to avoid opening any GUI
  elements (including pipeline interactive windows).
It is possible to specify workflow variables (those that appear in the workflow canvas) in the command line. For instance, the raw data directory can be set with this command:

```
esoreflex -n -RAW_DATA_DIR <raw_data_path> \\n<workflow_path>/<workflow>.xml
```

You can see all the command line options with the command `esoreflex -h`.

Note that this mode is not fully supported, and the user should be aware that the path to the workflow must be absolute and even if no GUI elements are shown, it still requires a connection to the window manager.

- **How can I add new actors to an existing workflow?** You can drag and drop the actors in the menu on the left of the Reflex canvas. Under Eso-reflex -> Workflow you may find all the actors relevant for pipeline workflows, with the exception of the recipe executer. This actor must be manually instantiated using Tools -> Instantiate Component. Fill in the “Class name” field with `org.eso.RecipeExecuter` and in the pop-up window choose the required recipe from the pull-down menu. To connect the ports of the actor, click on the source port, holding down the left mouse button, and release the mouse button over the destination port. Please consult the Reflex User Manual ([?]) for more information.

- **How can I broadcast a result to different subsequent actors?** If the output port is a multi-port (filled in white), then you may have several relations from the port. However, if the port is a single port (filled in black), then you may use the black diamond from the toolbar. Make a relation from the output port to the diamond. Then make relations from the input ports to the diamond. Please note that you cannot click to start a relation from the diamond itself. Please consult the Reflex User Manual ([?]) for more information.

- **How can I manually run the recipes executed by Reflex?** If a user wants to re-run a recipe on the command line he/she has to go to the appropriate reflex_book_keeping directory, which is generally reflex_book_keeping/<workflow>/<recipe_name>_<number> There, subdirectories exist with the time stamp of the recipe execution (e.g. 2013-01-25T12:33:53.926/). If the user wants to re-execute the most recent processing he/she should go to the latest directory and then execute the script `cmdline.sh`. Alternatively, to use a customized esorex command the user can execute

```
ESOREX_CONFIG="INSTALL_DIR/etc/esorex.rc"
PATH_TO/esorex --recipe-config=<recipe>.rc <recipe> data.sof
```

where INSTALL_DIR is the directory where Reflex and the pipelines were installed.

If a user wants to re-execute on the command line a recipe that used a specific raw frame, the way to find the proper data.sof in the bookkeeping directory is via `grep <raw_file> */data.sof`. Afterwards the procedure is the same as before.

If a recipe is re-executed with the command explained above, the products will appear in the directory from which the recipe is called, and not in the reflex_tmp_products or reflex_end_products directory, and they will not be renamed. This does not happen if you use the `cmdline.sh` script.
• **Can I reuse the bookkeeping directory created by previous versions of the pipeline?**
  
  In general no. In principle, it could be reused if no major changes were made to the pipeline. However there are situations in which a previously created bookkeeping directory will cause problems due to pipeline versions incompatibility. This is especially true if the parameters of the pipeline recipes have changed. In that case, please remove the bookkeeping directory completely.

• **How to insert negative values into a textbox?**

  Due to a bug in wxPython, the GUI might appear to freeze when attempting to enter a negative number in a parameter's value textbox. This can be worked around by navigating away to a different control in the GUI with a mouse click, and then navigating back to the original textbox. Once focus is back on the original textbox the contents should be selected and it should be possible to replace it with a valid value, by typing it in and pressing the enter key.

• **I've updated my Reflex installation and when I run esoreflex the process aborts. How can I fix this problem?**

  As indicated in Section 3, in case of major or minor (affecting the first two digit numbers) Reflex upgrades, the user should erase the $HOME/KeplerData, $HOME/.kepler directories if present, to prevent possible aborts (i.e. a hard crash) of the esoreflex process.

• **How can I include my analysis scripts and algorithms into the workflow?**

  EsoReflex is capable of executing any user-provided script, if properly interfaced. The most convenient way to do it is through the Python actor. Please consult the tutorial on how to insert Python scripts into a workflow available here: [www.eso.org/sci/data-processing/Python_and_esoreflex.pdf](http://www.eso.org/sci/data-processing/Python_and_esoreflex.pdf)